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Office/BackOffice Solutions Demo



About the demo

The Seattle Cycle demo is used to show the advantages of using the Microsoft Office and Microsoft BackOffice in a custom solution.  There are three different variations of the demo, depending on the type and amount of computer hardware you have at your disposal (Variation 3 is the best for delivering a compelling demo - however, it is also the most difficult to set up and deliver):



Variation 1:	Demo given standalone on a single WFW machine (takes approximately 5-10 minutes to setup)



Variation 2:	Demo given on two WFW machines connected to an NT server or workstation (takes approximately 30-50 minutes to set up)



Variation 3:	Demo given on one WFW machine and one Macintosh connected to an NT server or workstation (takes approximately 1 hour to set up).



If the demo is being given with two machines (variation 2 or 3), then an NT server is required to allow the two machines to share data.  Data sharing between the two machines can be accomplished either through a FoxPro database on the NT server or through a SQL Server database.  It is preferred that a SQL Server database be used in presenting this demo.



Required Computer Hardware

Depending on which variation of the demo you decide to give, you will need the minimum computer hardware configurations to build one of the variations listed above:



WFW Machine: 486/33, 12mb RAM



Macintosh: Quadra 800 with 16mb RAM or PowerMac 8100 with 16mb RAM



Windows NT server: 486/33, 12mb RAM



Installing Required Software

The following software is required for the machines listed above.  Specific details on how to install some of the software components are provided in the setup instructions below:



WFW Machine: WFW 3.11, Excel 5, Word 6, Project 4, Microsoft Mail client



Macintosh: System 7, Mac Excel 5 (68k or PowerMac), Mac Word 6 (68k or PowerMac), Mac TCP Admin (by Apple)



Windows NT server: NT 3.5 (server or workstation).   The demo can be run using a FoxPro database or a SQL Server database on NT.  If you are using a FoxPro database and you are giving the demo with a Macintosh, then you must install Windows NTAS with Mac File Services.  If you are giving the demo with SQL Server, you need SQL Server 4.21, Enterprise edition.  If you are giving the demo with a Macintosh and SQL Server, you need to install TCP/IP support for Windows NT, as well as install SQL Server with TCP/IP.  Details on setup are given below.





Installing Demo Files



For the WFW machine, create a directory named c:\seacycle.  Copy all of the files from the \files directory referenced above into the c:\seacycle directory - this will require approximately 6.2mb of disk space.  The complete file list is as follows:



access.mpp

cross.mpp

cycle.ini

cyclemac.xls

cycleoe.ldb

cycleoe.mdb

cyclewin.xls

dao2016.dll

forecast.dbf

global.mpt

mountain.mpp

msabc200.dll

msafin.dll

msain200.dll

msaju200.dll

msaole20.dll

msarn200.exe

multi1.mpp

offdata.dbf

project1.mpp

racing.mpp

soa200.dll

system.ldb

system.mda

tour.mpp

utility.ldb

utility.mda

wrkgadm.exe

xbs110.dll

xbs200.dll

xlodbc.dll

xlodbc.xla



For the Macintosh machine, create a folder named SeaCycle and copy the following files from the \files directory above into the folder:



cyclemac.xls

offdata.dbf

forecast.dbf



For the NT machine, if you are running the demo with a FoxPro database then copy the file Forecast.dbf from the \files directory into a shared directory on the NT machine.  If you are running the demo with a SQL Server database, then see below for information on setting up SQL Server.





Setting up Databases for the Demo

The demo makes use of two external database - one for holding financial data to be displayed in a pivottable in Excel, and one used for holding forecast scenarios.  



The OffData.dbf FoxPro Database



The OffData.dbf database is used by the PivotTable in the Excel portion of the application.  In order to access this database successfully, you must create a FoxPro 2.5 ODBC data source that references this database on your hard drive.  This is most easily accomplished under Windows by going through Windows Control Panel and on the Macintosh, by selecting ODBC from the Control Panels folder.  You can follow these steps



On Windows start Control Panel (on the Mac select Control Panels from the Apple menu).

Select ODBC.

Click the Add button to add a new data source (on the Mac, click Setup Data Sources and then click Add).

Select FoxPro Files from the list of installed ODBC drivers.  Select OK.

Under Data Source Name enter OffData.  Select FoxPro 2.5 for Version.  Click the Select Directory button and select the directory into which you installed all of the demo files.

Select OK.



The Forecast Database - FoxPro version



The forecast database can be either a FoxPro database or a SQL Server database.  The FoxPro database is named Forecast.dbf.  If you are doing variation 1 of the demo (demo given standalone on a WFW machine) then you must have the forecast.dbf file on the local machine.  If you are giving variation 2 (two WFW machines) or variation 3 (one WFW and one Mac) of the demo with a FoxPro database, the Forecast.dbf file must be placed on a Windows NT share where both clients can access the database (remember, if you are using a Mac, you must install Windows NTAS with Mac file services).  Once you have the database in place, you must set up an ODBC data source named FoxForecast to be used by the demo.  You can follow the steps outlined in the section above for setting up an ODBC data source named FoxForecast.



The Forecast Database - SQL Server version



If you are giving variation 2 or variation 3 of the demo with a SQL Server database, then you must install SQL Server 4.21 on the Windows NT server or workstation (note that using SQL Server with the Mac does not require installation of Mac File services - you can install standard NT 3.5).  When you first install NT 3.5, if you are using a Mac with the demo, be sure to install TCP/IP network support.  When you install TCP/IP on NT, you will be prompted for a TCP/IP number, a Subnet Mask and a Default Gateway.  You must obtain these numbers from your system administrator.



When installing SQL Server 4.21, be sure to do the following during the installation process:



When you are prompted for Installation Options, for Sort Order select “Dictionary order, case insensitive”.

If you are using a Macintosh, under installation options, select Additional Network Support and then select TCP/IP Sockets.

After specifying Installation Options, the SQL Server installation program will display a four digit port number.  If you are using a Macintosh, you will need this port number - write it down.



After installing SQL Server 4.21, you will have set up a database for use in the demo.  Follow these steps to set up the database:



First, start the SQL Service by selecting Start in the SQL Service Manager.

Start the SQL Administrator and connect to the SQL Server (logon as sa with no password).

Click the Devices button.

Select Manage-Devices-Create.  For Logical Name, enter Sales.  For Type, select Database.  For size, enter 15mb.  Click OK.

Under Devices, select Manage-Devices-Create a second time.  For Logical Name, enter Log.  For Type, select Database and for Size, enter 15mb.  Click OK.

Close the Devices window.

Click the Database (DB) button.

Select Manage-Database-Create Database.  For Database Name, enter Revenue.  For Data Device, select Sales.  For Log Device, select Log.  Click OK.  You will receive two messages - click OK to both.

Close the Database window and exit out of SQL Administrator.

Start the SQL Object Manager and connect to the SQL Server.

Click the Objects button.  Select Revenue from the Current Database drop-down list box.

Select Manage-Tables.  A Manage Tables window will appear for the Revenue database.

From the Tables drop-down list box in the Manage Tables window, select New Table.

For the first column enter Scenario for Column Name and select text (SQL Type) for Datatype (you can select the datatype from the Properties drop-down list box).

For the second column enter West for Column Name and select float (SQL Type) for Datatype.

For the third column enter Central for Column Name and select float (SQL Type) for Datatype.

For the fourth column enter South for Column Name and select float (SQL Type) for Datatype.

For the fifth column enter East for Column Name and select float (SQL Type) for Datatype.

Click the Create button to create the new table.  Enter Forecast for New Table Name.

Close all open windows and exit the SQL Object Manager.



Now that you have created the SQL Server database, you must now put some data into the database before it can actually be used in the demo.  Before doing so, you must create an ODBC data source named SQLForecast that references the database.  Use the following steps on a WFW machine.  The process for setting up the Macintosh to connect to SQL Server is detailed below in the section titled “Setting up the Macintosh to read SQL Server data”.



On Windows start Control Panel.

Select ODBC.

Click the Add button to add a new data source.

Select SQL Server from the list of installed ODBC drivers.  Select OK.

Under Data Source Name enter SQLForecast. For Server, enter the name of your SQL Server (which is the same name as your Windows NT machine).

Select OK.



After setting up the SQLForecast ODBC data source, you must enter some data into the database.  This is most easily accomplished by using Microsoft Query from Excel.  Follow these steps:



Start Excel.

Select Tools-Addins.  Make sure that MS Query is checked in the Add-ins dialog box.  Click OK.

Select Data-Get External Data.  This will launch Microsoft Query.

On the Select Data Source dialog box, click the Other button.

Under Enter Data Source, select SQLForecast.  Click OK.

Enter sa for Login ID.  Do not enter a password.  Click OK.

Back in the Select Data Source dialog box, select SQLForecast and then click the Use button.

In the Add Tables dialog box, select Revenue from the Database drop-down list box.  Select the Forecast table and click the Add button.  Click Close on the Add Tables dialog box.

Add all of the fields from the Forecast table by double-clicking on the asterisk (*) in the Forecast table field name list box.  After doing so, you will notice all of the field names appear in the data area in the lower portion of the screen, however, there will be no data in the table.

From the Records menu, select Allow Editing.

Enter the following four records into the table: �

After you are done entering the four records, select the Records menu and turn off editing by selecting Allow Editing.

Close Microsoft Query.  Do not return the data to Excel.



Setting up the Macintosh to read SQL Server data



If you are including a Macintosh in this demo, then you must setup the Macintosh to read SQL Server data through TCP/IP (you should be able to read SQL Server data through AppleTalk, however this has not been tested).  To read data through TCP/IP on the Mac, you must obtain a program from Apple Computer named Mac TCP Admin and install it in the Control Panels folder on your Macintosh.  After installing Mac TCP Admin, go to Control Panels and start Mac TCP Admin.  You will have to obtain a TCP/IP number from your system administrator for the Macintosh.  Follow these steps to set up TCP Admin:



Start TCP Admin.

In the first TCP Admin dialog, enter the TCP/IP number under IP Address.  Also be sure to select the type of network you are using (Ethernet).  Click the More button.

Under Gateway address, enter the same Default Gateway that you used for your NT machine.

Enter the same Subnet Mask as you are using for the NT machine (you adjust the Subnet Mask in TCP Admin by dragging the sliders).

Under Domain, enter the name of the SQL Server (the name of the NT machine).  Under IP Address for the domain, enter the TCP/IP number you used for the NT machine.  Click the Default option button next to the IP Address box.

Select OK and then exit TCP Admin.  Restart your Macintosh.



After setting up Mac TCP Admin, you will have to set up an ODBC data source on your Macintosh that references the SQL Server database.  Follow these steps:

From the Apple menu, select Control Panels.

Select ODBC.

Click the Setup Data Sources button and then click the Add button.

Select SQL Server from the list of installed ODBC drivers.  Select OK.

Under Data Source Name enter SQLForecast. For Server, enter the name of your SQL Server (which is the same name as your Windows NT machine).  For Network Address, enter the TCP/IP number for the NT workstation followed by a comma followed by the four digit SQL Server Port number.  You should have received the four digit port number when you first installed SQL Server (you can run SQL Server setup to obtain the number).  The TCP/IP number and port number should look like the following:  11.116.66.103,1433.  After entering the TCP/IP number and port number, select TCP/IP from Network Library and then select OK.

Close ODBC Setup.





�About this Demo

Introduction

The steps in the following demo are intended to be given in the exact order as they are scripted.  Failure to follow the steps exactly may result in unexpected behavior.  The demo is solid, however, it is recommended that you adhere to the script.  Delivery of this demo takes 10-15 minutes.



Before starting the demo

Before starting the demo, do the following:



Make sure that no applications are running on any of the machines that you are using in the demo.  

If you are using a SQL Server for the demo, make sure you’ve started Windows NT, you’ve logged onto NT with your client machines and that you have started the SQL Service.  

On your first WFW client, start Excel and load the file Cyclewin.xls.  

If you are using a second WFW machine - on the second machine, start Excel and load the file Cyclewin.xls.  

If you are using a second Mac machine, start Microsoft Word.  Then, start Excel and load the file Cyclemac.xls.  

When you start Cyclewin.xls or Cyclemac.xls you will be prompted with a dialog box requesting the type of Forecast database that you are using.  Select either FoxPro or SQL Server depending on the type of database you have set up for the Forecast database (if you are using FoxPro, you must have an ODBC data source named FoxForecast, however, if you are using SQL Server, you must have an ODBC data source named SQLForecast - see above for details).  If you receive an error message after selecting the Forecast database, then the application had trouble reading data from the ODBC data sources - the application will automatically close at this point.  If you encounter an error, go back and make sure that you have set up the OffData and either FoxForecast or SQLForecast ODBC data sources correctly.





�Demo Script



Note: This script is worded with the assumption that the demo is being given with one WFW client, one Mac client and one Windows NT machine running SQL Server.  If you are doing a different variation of this demo, adjust the script accordingly.



Introduction to Office as a Solutions Platform��While many consider the Microsoft Office to be a very strong set of end user tools - including spreadsheet, word processor, database and presentation graphics program - the Office is also a very powerful development platform.  With the latest version of the Office, we’ve broken up the Office applications into sets of discreet programmable objects - all of the functionality in Office applications can be accessed through these programmable objects.  We’ve also incorporated common macro languages built on Visual Basic Technology.  In Microsoft Excel and Microsoft Project, there is Visual Basic for Applications, while in Access, there is AccessBasic and in Word, WordBasic.  All of these macro languages are based on Microsoft’s award winning Visual Basic Programming System.  Because there are common macro languages across the Office applications, it is very easy to learn one application’s macro language and then move to another application with very little learning.  Additionally, all of the office applications support OLE 2 - OLE Automation is a feature of OLE 2 that essentially breaks down the barriers that separate applications, making it very easy to write a macro in one application that controls or sends data to another application.  A powerful set of objects, common macro languages based on Visual Basic and support for OLE Automation combined make the Microsoft Office one of the most powerful development platforms available for the Windows, Windows NT and Macintosh environments.

����Seattle Cycle��Today we’ll be looking at an application developed for a fictitious company named Seattle Cycle using Microsoft Office and BackOffice products.  On the client end, the application employs Microsoft Excel, Access, Project and Word.  The client application based on the Office uses data from a SQL Server database running on Windows NT.  And in fact, we can have several client machines running this same application and sharing data real-time through the SQL Server database on the NT server.  We can even run this same application on a Macintosh or on a Windows NT Workstation - today we’re running this same application on a pc running Windows for Workgroups 3.11 and an Apple Macintosh running System 7.  Because the different versions of the Microsoft Office are built on top of core-code, we can develop an application on one platform and run that same application on a different platform unmodified.  Features such as these make it very easy for you to quickly develop and deploy applications throughout your company.

��Start the demo on the WFW machine.

Point out the main screen of the Seattle Cycle application running on the WFW client.��Main Screen��We’re currently looking at the main screen of the Seattle Cycle application.  We’re actually running Microsoft Excel right now, although there are no visual cues to indicate to the user that Excel is actually running.  Using Visual Basic for Applications in Excel, we have been able to completely customize the Excel interface - you’ll notice we have a custom title bar, custom menus, and a lot of custom graphics on the screen.  Now different parts of this application have been designed to be used by different people within the company.  There is an area of the application that is used by manufacturing as indicated here by the Production button.  There’s also an area of the application which is used by the sales force to enter orders.  The area of the application behind the Sales Analysis button is used by the finance department to analyze sales data and the Forecast module is used by the marketing staff to generate and share forecast data.  While different modules of this application are used by different people in different functional roles in the company, the interface you see here can be used by an executive in accessing all areas of functionality of the application.  Why don’t we go ahead and take a look at the application.

��Point out the elements of the main Seattle Cycle screen on the WFW machine.��The Production Module - Microsoft Project��By clicking on the Production button I can access the module of the application which is used by the manufacturing department.  This takes us into an Excel screen which displays our current production schedule in the table above the chart.  Now, I know that this schedule is not current - I would like to update this schedule to see where we are today.  Now, the company does all of it’s production scheduling in Microsoft Project - the world’s leading project management software for the PC and the Macintosh.

��Click on the Production button��Updating the Project��By clicking on the Consolidate Projects button, I can actually go into Microsoft Project to take a look at the production schedule.  We are able to go from Excel to Project so seamlessly with a click of a button because of support for OLE Automation by both Excel and Project.  OLE Automation, in effect, breaks down the barriers that separate applications - I can develop a macro in one application that easily shares data with another application.



Microsoft Project also includes Visual Basic for Applications - we’ve used VBA here to customize the Project interface - you’ll notice a custom toolbar and custom menus - customization such as this allows developers to take Office applications and make them easier to use for the specific task at hand.



In Microsoft Project, I can view production schedules for the three product lines - Racing Bikes, Touring Bikes and Accessories - you can see the schedules graphically displayed in the Gantt charts on the right side of the screen.

��Click Consolidate Projects button to launch Microsoft Project��Project - Resource Usage��If I select Resource Sheet from the View menu, I can actually look at the resources that I’m using in these different production projects as well as the hourly rate for each resource.

��Select Resource Sheet from the View menu.��Project - Increase Resource Rates��Now, the company has been doing very well lately, so I’d like to go ahead and give everyone an across the board raise.  By clicking the Increase Resource Rates button on the custom toolbar, I can launch a VBA macro that will allow me to increase my resource rates.  I’ll go ahead and give everyone an 8% raise - notice how VBA automatically goes through and increases the rates of all the resources appropriately.

��Click the Increase Resource Rates button on the custom toolbar.

Enter 8 to increase resource rates by 8%.

Click OK.��Project - Update as of Today��Let’s go ahead and go back to the Gantt chart.  I’d now like to see where we actually are in the production schedule as of today.  By clicking on the Update as of Today button on the custom toolbar, I can launch a VBA macro that will automatically display a red line on the Gantt bars that shows where we are in the production schedule today.

��Select Gantt Chart from the View menu.

Click the Update as of Today button on the custom toolbar.��Project - Send Task Update (note if MS Mail is not installed, this part of the demo will fail)��The last thing I would like to do in analyzing the production schedule is to send an individual  task report to each person involved in the production schedule.  Because of Microsoft Projects tight integration with MAPI, or Microsoft’s Messaging API, I can easily send out task updates throughout the email system to let individuals know how they fit into the overall production schedule.  If I click the Send Task Update button, this will launch a VBA macro that will summarize tasks for all individuals involved and send the information out through Microsoft mail - as you can see here.  I’m going to go ahead and cancel this.

��Click the Send Task Update button on the custom toolbar. 

After the dialog box is displayed, click the Cancel button to dismiss the dialog.��Project - Return and Update Excel��Now that I have finished analyzing my production data in Microsoft Project, I would like to get this updated data back into Excel.  If I click on the Return and Update Excel button on the custom toolbar, this will launch a VBA macro in Project that will take the data out of Project and transfer it to Excel via OLE Automation.  As we see Excel coming up here, you can actually see the numbers being updated in the Excel table.  Again, OLE Automation essentially breaks down the barriers between applications, making it very easy to share data.

��Click the Update and Return to Excel button on the custom toolbar to return the data back to Excel.��Excel - Return to Control Screen��Okay, let’s move on with the application and return to the control screen.��Click the Control button to return back to the Excel control screen.��Access - Order Entry��The next module of the application is that used by the sales force in entering orders from customers out in the field.  I can access this module by clicking on the Order Entry button on the control screen.  The company’s sales reps use this application to take orders that are saved in a local database on their notebook computers.  Order data is then transferred to the main SQL Server database once the sales rep returns to the Office.

��Click the Order Entry button on the Control screen to launch the run-time Access order entry application.��Access - Entering a new order��We are actually looking at a run-time Access module here - that is, Microsoft Access is not actually installed on this computer.  Using Access, we can create run-time applications that can be distributed at no charge - users don’t even have to have Access to run them.  Let’s go ahead and enter a new order.



I’ll first click the Enter Order button.  I then can easily select a customer from this drop down - Great Lakes Bike Shop.  If I click on the ProductID box, you’ll notice that a list box automatically appears making it easy for me to select the product to be ordered.  I’ll go ahead and select the Titan 2 racing bike and a quantity of 10.  When I’m done entering the information, I just select the Post Order button and the order is posted to the local database.



The powerful customization features in Access allow you to create intuitive interfaces that are very easy to use - as we’ve seen here.

��Click Enter Order button.

Select Great Lakes Bike Shop from the Customer drop-down list box.

Click in the ProductID cell and select Titan 2 from the Product drop-down list box.

Enter a quantity of 10, then click out of the quantity cell.

Click the Post Order button to post the order to the local database.��Access - Print Invoice��We’ll, let’s go ahead and take a look at an invoice for this order.  Microsoft Access provides some very powerful report-creation functionality.  By clicking on the Print Invoice button, I can launch an AccessBasic macro that automatically creates a report that summarizes the order I just entered - in invoice format.  If I click once in the body of the form, I can actually zoom-out to take a look at the whole report.

��Click the Print Invoice button.

In the Report form, click once in the body of the form to zoom-out to view the whole form.��Access - Send Report (if MS Mail is not installed, you cannot do this portio nof the demo)��I can now print this report - or I can even send the report over email.  In fact, I can send the report directly to the customer over the Internet.  I’ll go ahead and select Send from the File menu and package this report as a Word document in rich text format in an email message.  I can then address the email message to the customer’s Internet address and send it directly to them.



By using AccessBasic and various other customization features available through Microsoft Access, I have been able to create a very powerful run-time application that can be used by the sales force to easily enter and report sales orders.

��Select Send from the File menu.

Select Rich Text Format and then OK.

After the dialog box is displayed, select Cancel to dismiss the dialog.��Excel - Control Screen��Let’s return back to our control screen in Excel and take a look at other parts of the application.  I’ll just close the report window and then click the Close button to get back into Excel.

��Close the Report window.

Click the Close button on the Access form to return back to Excel.��Excel - Data Analysis��Okay, after the sales representatives enter their orders in the field, they upload all of their order data to the company’s central SQL Server database.  People in the finance dept can use the powerful data analysis features in Excel to analyze this sales data and get a good understanding for how the business is doing.  Let’s go ahead and take a look.  By clicking on the Sales Analysis button, I can access an Excel module that allows me to analyze sales data.

��Click the Sales Analysis button on the Excel control screen.��Excel - PivotTable��On the first form here in Excel, there is a table in the middle of the screen that displays sales data for the company broken down by weeks for 1994.  You can see that we have the different product categories listed across the tops of the columns of the table and the dates going down the rows.  In the dropdown list box at the top of the table, you can see that we are currently looking at data for the Eastern region - but notice how I can select different regions from the dropdown to look at data for different areas within the United States in which the company does business.  I can look at data for the Western region, the Central region, etc. - notice how every time I select a new region, the pivottable automatically updates to show me data specific to the selected region.  Excel’s pivottable feature provides a very powerful interface for viewing large amounts of database data - in a format that is very easy to understand.

��From the pivottable dropdown list box, select West, then select Central.��Excel - PivotTable Grouping��Currently in the pivottable, we are looking at data on a monthly basis.  If I want to consolidate the data to look at it in a quarterly basis, all I have to do is click the Display Quarterly Data checkbox above the table.  Notice that when I do so the data in the table is grouped into quarters.  If I click the checkbox again, the data is displayed in months.

��Click the Display Quarterly Data Checkbox to consolidate the data in quarters.

Click the Display Quarterly Data checkbox a second time to return to a monthly display.��Excel - PivotTable - changing data display��You may have also noticed this list box above the table with the four items - Normal, Percent of Row, Percent of Column and Percent of Total.  By selecting any of these items, I can display the data in the table in terms of percentages.  For example, selecting Percent of Row, displays data in percentages across each row so that they add up to 100%.  Percent of Column breaks the data down in percentages going down each column, while Percent of Total breaks all the numbers in the table down into percentages that add up to 100%.  This is all accomplished with VBA - the powerful data analysis features that are built into this particular interface make it very easy for someone in the finance department to analyze a large amount of data with very little effort.  And it really doesn’t take much effort on the part of the developer to create interfaces such as these.

��Click Percent of Row in the list box above the pivottable.

Click Percent of Column.

Click Percent of Total.

Click Normal.��Excel - Charts��After analyzing the numerical data, it would be really great to look at the data graphically.  By clicking on the Chart button, I can access an Excel interface that displays the same data that we viewed in the pivottable in an Excel chart.

��Click the Chart button to go to the Chart screen.��Excel - Charts��We’ve created this custom chart interface here in Excel to give the user the option of viewing graphical data from various different perspectives.  The chart displayed here is actually linked to the pivottable that we saw on the previous screen - if the data in the pivottable changes, the chart automatically updates.



You’ll notice that there is a dropdown list box above the chart that let’s us look at data for the different regions in which the company does business - just as we did with the pivottable.  I can look at data for the Western region, the Central region, etc. - every time I select a new item from the dropdown, the chart automatically updates to display data for the region I’ve selected.

��Select West from the DropDown list box above the chart.

Select Central from the DropDown list box above the chart.��Excel - Charts, group data��Also notice that there is a Display Quarterly Data checkbox in the chart screen, just like we had in the pivottable screen.  By clicking the check box, I can have the graphical data broken down into quarters - or by unchecking the box, return back to months.

��Click the Display Quarterly Data Checkbox to display quarterly data.

Click the Display Quarterly Data checkbox a second time to return to monthly display.��Excel - Chart types��Over here on the left side of the screen we have a series of four option buttons.  By clicking on the different option buttons, I can have the graphical data displayed using different chart types - 3D Column, 3D Surface, 3D Area and 3D Line.

��Click the 3D Surface option button.

Click the 3D Area option button.

Click the 3D Line option button.��Excel - Chart rotation and elevation��And by using the two scrollbars in the lower left hand corner of the screen, I can actually adjust the rotation and the elevation of the chart to view the graphical data from different angles.



The interface that has been developed here to view graphical data is actually a very powerful interface - we like to refer to such an interface in Excel as a “graphical chart book”.  With the various controls and VBA macros that have been implemented here, the user can actually view hundreds of charts - all from this single interface by using these different controls.  Office interfaces such as these are not that difficult to develop - and they provide a tremendous amount of power to anyone that is doing data analysis, allowing users to understand more information in less time and make better decisions.

��Click the right arrow of the horizontal scrollbar 5 times.

Click the up arrow of the vertical scrollbar 5 times.��Excel - Control Screen��Let’s go back to the main control screen now and take a look at the last module in this application.







��Click the Pivot button on the Chart screen to return to the Pivot Screen.

Click the Control button on the Pivot screen to return to the Control Screen.��Excel -Forecast��The last module of the application is used by the marketing department to generate forecasts.

��Click the Forecast button to go to the Forecast screen.��Excel - Scenario Manager��In the Forecast screen we have a table that displays data for the four different regions in the United States in which the company does business - West, Central, South and East.  For each region, the table displays actual sales data for 1994 and a forecast for 1995.  You’ll notice that up in the right hand corner of the screen, there is a dropdown list box that tells us that we are currently looking at the Base scenario.  However, I can select other scenarios from the dropdown if I want to.  For example, I can look at the Worst case scenario or even the Likely case scenario.  You’ll notice that as I select a new scenario from the dropdown that the numbers in the table update to reflect the new scenario - the chart below the table updates as well as the chart is actually linked to the table.  This interface makes extensive use of Excel’s Scenario Manager feature - it’s a powerful feature that allows multiple users to enter multiple assumptions - all within a single Excel spreadsheet.

��Point out the values in the table.

Select Worst Case from the Scenario dropdown list box in the upper right corner.

Select Likely Case from the Scenario dropdown list box.��Excel - Geographic Map��Now, you’ll notice down here we have some option buttons.  If I click on the Map option button, this will display a color coded map of the United States.  The different regions of the map - West, Central, South and East - are shaded differently to make them stand out.  The regions are colored according to the level of forecasts.  Regions forecasted at under 10% growth are colored red.  Regions forecasted at between 10% and 50% growth are colored green and regions forecasted at greater than 50% growth are colored blue.  You can see that as I select different scenarios from the dropdown list box the colors in the map change.  If I select the Worst case scenario, the map is all red, if I select likely case, the map is all green and if I select Best case the map is all blue.

��Click the Map option button to display the map of the United States.

Select Worst Case from the Scenario list box.

Select Likely Case from the Scenario list box.

Select Best Case from the Scenario list box.��Excel - Macintosh��Now, let’s move over to the Macintosh.  You’ll notice that we have the exact same application that we’ve been using under Windows for Workgroups running on the Macintosh.  Because the different versions of the Microsoft Office are built on top of core code, you can write an application once on one platform and use that same application on other platforms without having to modify the application.  Here we have developed an application under Windows for Workgroups, and we’re now running this application on the Macintosh - we could also run this application on Windows NT as well.



I’m going to go ahead and click the Forecast button to go to the Forecast screen and then click the Map button to have the map of the United States displayed.  You’ll notice that if you look at the scenarios in the dropdown list box in the upper right corner of the screen - they are the exact same scenarios that we were working with on the Windows for Workgroups machine.  The scenarios that we are using here are actually being shared through a SQL Server database running on a Windows NT server.  You can see that I can look at the exact same scenarios - Worst Case, Likely Case and Best Case.

��Move to the Macintosh machine.

The main control screen should already be displayed on the Mac.  Select the Forecast button to go to the Forecast screen.

In the Forecast screen, select the Map option button to have the map of the United States displayed.

From the dropdown list box, select Worst Case, Likely Case and Best Case to show how the map changes.��Excel - Macintosh, Add New Scenario��Well, looking at these scenarios, I find that I don’t really agree with any of the scenarios.  And what I would really like to do is to add my own assumptions for how the company is going to do in 1995.  So, I’m going to go ahead and enter my own growth figures.  Let’s see, for the Western region, we’re not doing so well, so I’ll enter -5%.  For the Central region, I’ll enter 35%.  For the South - I know the company is doing very well there, so I’ll enter 100% and then in the East, we are not doing well at all, so I’ll go with -50%.



I would now like to add this scenario, so I’ll go ahead and click the Add Scenario button.  I’m going to go ahead and give this scenario the name Revised and select OK.  Now, when I add a scenario, two things happen.  First of all, the application updates the colors in the map - notice the areas with low forecasts are red while the areas with higher forecasts are green and blue.  Second, the application took the numbers that I entered for my forecast and immediately exported them to the SQL Server database - so that now, anyone who is running this application within the company has instant access to the assumptions I have entered for my forecast.



��Enter -.05 in the Growth cell for the West region.  Press Enter.

Enter .35 in the Growth cell for the Central region.  Press Enter. 

Enter 1 in the Growth cell for the South region.  Press Enter. 

Enter -.5 in the Growth cell for the East region.  Press Enter.

Click the Add Scenario button.  Enter Revised in the Scenario Name box.  Click OK to add the scenario.

Before leaving the Macintosh to move back to the Windows for Workgroups machine, click the Fast Poll checkbox on the Macintosh interface.  This will cause the Macintosh to poll  the database every 10 seconds.��Excel - Windows - Data from SQL Server��If we now move back to our Windows for Workgroups machine, we can look in the list of scenarios available to us in the scenario dropdown list box and we can see that the Revised scenario that was added using the interface on the Macintosh has been added to the list.  When we added the Revised scenario on the Macintosh, the data was sent to the SQL Server database and became immediately accessible to the application running under Windows for Workgroups.  This provides evidence of the powerful workgroup data sharing capabilities of Office/BackOffice solutions.

��Move back to the Windows for Workgroups machine.

Select Revised from the DropDown list box.  If the Revised scenario does not appear in the dropdown list box, click the Query Now button and try again.  The application automatically polls the database every 30 seconds - however, clicking Query Now will cause it to poll immediately.  Try the dropdown list box again after clicking Query Now.��Excel - Windows - Changing Scenario��Well, let’s say that I’m another user in the company and I’m now looking at the Revised scenario, and I don’t agree with the assumptions.  Let’s say that I’m much more optimistic about the company’s prospects during 1995.  I’m going to go ahead and enter in 200% growth for each region.  I’m now going to click the Add Scenario button and this time, I’m going to keep the same name for the scenario - that is, Revised.  This will effectively change the numbers for the Revised scenario.

��Make sure the Revised scenario is displayed.  Enter 2 in the Growth cells for all four regions - West, Central, South and East.

Click the Add Scenario button.  Keep the same name of the scenario - Revised.  Select OK and then select Yes to the box asking if you wish to change the current scenario.��Excel - Macintosh, view changed scenario��Okay, let’s move back to the Macintosh now - because the application on the Macintosh is automatically polling the SQL Server database, we should see the map on the Macintosh automatically update to display colors for the numbers we just entered on the Windows for Workgroups machine.  And sure enough, the Map does change to display blue for a very high forecast for each region.

��Move back to the Macintosh.

Make sure the Fast Poll check box is checked and make sure the Revised scenario is displayed in the dropdown list box (these should already be set).  The map should automatically change to all blue.��Excel - Macintosh, Create Report with Word��Well, the last thing I would like to do is to create a report that summarizes my forecast assumptions.  By clicking the Report button, I can automatically create a report in Microsoft Word.  Not only are Microsoft Office applications supported on both the Windows and Macintosh platforms, but Microsoft technologies such as OLE and ODBC are supported as well.  Here we are running a VBA macro in Excel that is creating a report in Microsoft Word through OLE Automation.  Remember, OLE Automation effectively breaks down the barriers between applications allowing me to write a macro in one application that seamlessly shares data with another application.  As this macro runs, you’ll notice that we are actually taking data out of Excel and placing it into the report in Word and making use of Word’s advanced formatting functionality to create a professional looking report.

��Microsoft Word should already be running on the Macintosh (Word should have been started before the demo).  

Turn off the Poll Data checkbox.

Click the Report button to create a report in Mac Word through OLE Automation.��Excel - Windows, Create Report with Word��Now we can move over to the Windows machine and run the exact same macro and you will notice that it executes in the exact same manner - you can see the data from Excel being placed into the Word report.��Move back to the Windows for Workgroups Machine.

Turn off the Poll Data checkbox.

Click the Report button to create a report in Word through OLE Automation.��Summary��What I’ve shown you today is an example of a custom application built using the Microsoft Office and BackOffice.  This application allows us to access a wide variety of areas within the business  - letting us analyze data to make better decisions.  The application takes advantage of the common macro languages, the rich set of programmable objects and support for OLE 2 in the Office, as well as the powerful data management and data sharing functionality provided by SQL Server and Windows NT.



Applications such as these are actually not that difficult to create.  This particular application was created by a couple of people in our Office marketing group in a period of about two weeks - and believe me, our marketers are not considered professional developers.



In this application, we saw how Office and BackOffice can be used together to deliver a powerful interface for accessing and sharing information throughout the company - information that will ultimately lead to better decisions and a true business advantage.

����
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